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Peter Faulks –  Photoshop 


	Title or Task: 

	Photoshop 

	Description:
	Using the selection tools select various elements from the following files

	Files Required
	

	Suitable for Classes:
	Multimedia, Small Business, Applied Information Technology Certificate II

	Area:


	Technology & Enterprise (ICT)

	Teacher: 

	Mr Peter Faulks

	Timeline 

	2 lessons (this lesson requires 2 sessions)

	Date Due:

	In class

	Task Brief:
	This session requires some skill in using the mouse and various selection tools, it is used to take students through some basic aspects of Photoshop. It was based on Photoshop CS3 so some variations will occur if using other versions. It is rated easy and should give students confidence in starting Photoshop

	Development or Outcomes:
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Items highlighted in yellow are tasks for you to complete

Items in Blue italics are help tips

These pages are designed to show you how to use software packages; various software updates may have taken place so some pages will not apply to versions other than those listed here. In some cases data files may be required.

Copy these images to your folder or download the Photoshop_Images.zip
At the end of this document are some help pages that revise some of the tool functions

Simple logo design ideas using custom shapes in Photoshop

Learn how to create logo designs using shapes, styles, gradients in Photoshop. 

Logos are very important parts of web designing and they can be made with letters and graphics. Here we will learn to design simple logos using custom shapes in Photoshop. 

Click here for ready-made Photoshop logo designs 
Smart, Colourful and unique Bird Logo 

  [image: image1.jpg]



Let's start designing the logo. It's very simple.
Step 1: Open a new file by clicking on File>New choose International and A6  as shown
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Step 2: Create a new layer. Name it logo.

Step 3: Choose the [image: image3.jpg]


custom shape tool seen in the tools panel on the right. [image: image4.jpg][mmol ¢ #E000 NG|
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The above panel will appear. 

Select Styles and as follows…


Step 4: Click on the Shape drop down menu seen on the top toolbar. Click on the arrow and select Animals. Select style as Buttons. Look for the angled spectrum button which is there. Look for the bird which is in the banner and drag it to the canvas with the size you want. 

You may need to append the buttons to the styles 
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   Use  the little arrow on the style drop down and select Buttons then click Append (these will be at the bottom)
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Now find the button angled spectrum button
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Wow! Your nice colourful Bird logo is ready!

Bright Sun Logo 
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Follow the steps:
Step 1:Choose the [image: image10.jpg]


custom shape tool seen in the tools panel on the right. Click on the Shape drop down menu seen on the top toolbar. 

Click on the arrow and select Nature. 
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Look for the sun symbol which is there and drag it to the canvas with the size you want or draw it on your canvas.

Make sure the mode is set to RPG 
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Select two colours in the Foreground and background palette I chose red (fb3204 ) and light yellow (eee2b3)
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Step 2:Now click on magic wand tool [image: image12.jpg]


 and ste this to 32 then select the sun arms. Now create a gradient. Select Gradient tool[image: image13.jpg]


 . Select or use your colours or Color harmonies2 from the dropdown menu of gradient tool and chose the gradient which has orange to yellow gradient. Now click on the sun and drag from top to down. Your sun have the sun effect now. 
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Play with the Gradient types and make your sun

Change the center gradient to radial Center and drag from the center

Paste three samples below:

Select Fill pixels [image: image15.jpg]Rekeir)



(third button seen in the tools panel in the left). 

Step 3:To make the text appear on top of the sun.
Click on [image: image16.jpg]


and the below panel will appear on top of the photoshop file. [image: image17.jpg]



Select T[image: image18.jpg]»



 and the below screen will appear.
Warp Text Screen Click on style as Arc Say ok.
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Now you can write your company name.

Your logo is ready! 

Here is the logo we designed for the Free Photoshop website template 2.
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Follow the steps: 
Choose the [image: image21.jpg]


custom shape tool seen in the tools panel on the right. Click on the Shape drop down menu seen on the top toolbar. Click on the arrow and select Ornaments. Look for the ornament which is in the banner of website header 2. Here give color as Black. Drag the shape to the canvas.

Easy isn't it? Click here to learn how we designed website template 2. 

Here is the logo we designed for the Free Photoshop website template 3.
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Follow the steps: 
[image: image23.jpg]


custom shape tool seen in the tools panel on the right. Go to Shape tool[image: image24.jpg]


Click on this Shape drop down menu. Click on the arrow and select Symbols. Look for the star symbol which is in the banner of website header 2. Click on the color as #A83C56.
Drag the star in the canvas.

Your logo is ready!!! Click here to learn how we designed website template 3 .

Smart Star Logo 
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Follow the steps:
Choose the [image: image26.jpg]


custom shape tool seen in the tools panel on the right. Click on the Shape drop down menu seen on the top toolbar. Click on the arrow and select Nature. Select style as Texture. Look for the pixelated texture which is there. Look for the star which is in the banner and drag it to the canvas with the size you want. 

Your logo is ready!

Attractive Fire Logo 
  [image: image27.jpg]



Follow the steps: 
Step 1:First choose the [image: image28.jpg]


custom shape tool seen in the tools panel on the right. Click on the Shape drop down menu seen on the top toolbar. Click on the arrow and select Symbols. Look for the first symbol which is in the banner.Select Fill pixels [image: image29.jpg]Rekeir)



(third button seen in the tools panel in the left). Drag the fire symbol to the canvas.
Step 2:Now click on magic wand tool[image: image30.jpg]


 and select only the flames. 
Step 3: Now create a gradient. Select Gradient tool[image: image31.jpg]


. Select Color harmonies2 from the dropdown menu of gradient tool and chose the gradient which has orange to yellow gradient. Now click on the flames and drag from top to down. Your flames have the color effect of fire. 

Step 4:Now choose the wood with magic wand tool and select the wood. Now choose a wood color like brown and fill it while choosing paint tool. Now go to filter/pixelate/fragment to get the wood effect. 

Your fire logo is ready! 

Congratulations! Your logo design is ready!

This Ends this Session 

Help & Revision material

Brush sizes 

Note: It is useful to increase or decrease the brush size;  select a brush type, soft edge hard  edge or and effects brush...   then use this slider 

to change the size. 

Drag the mouse over the image to check the size of the brush.

The Layers Palette

The Layers palette is your essential tool for working with layers. It contains a list of all your layers (referred to by name), starting with the topmost layer, and provides a thumbnail of the contents of each layer. Only one layer can be active at a time; the active layer is selected. You can use the Layers palette to perform many tasks (e.g., create, delete, hide, merge, and flatten layers).

To open the Layers palette:

    1.
From the Window menu, Layers (F7)
The Layers palette appears on the Photoshop window.

To close the Layers palette:

From the Window menu, select Hide Layers
OR

Click the X in the upper right hand corner of the Layers palette

The Layers palette disappears from the Photoshop window into the dock – if you want you can drag the dock out onto the screen.


Add new layer style

    Layer mask

     Create a new set, 

Create a new fill or adjustment layer

New layer  

Trash delete layer 

Hiding/Displaying Layers

You may find it useful to hide layers while working in Photoshop. For example, when merging layers, you can hide some layers so that they will not be merged. Visible layers have an EYE icon next to them, hidden layers do not appear when you save your work.
You can toggle between visible and hidden by clicking in the corresponding layer's Eye column.

Eyes shows or hides layer,  






layer above is on top move up or down or add a new layer.



Help Note: Layer Selection Tips

When you select (i.e., click) a layer in the Layers palette, that layer is active. Review the following tips to learn about selection rules:

Only one layer can be active at a time, (highlighted in blue).

The name of the active layer appears in the title bar of the image window. 

Changes affect only the active layer even though you view the whole image in the image window.

To hide several layers:

On the Layers palette, click the EYE icon corresponding to the layer(s) (and background) you wish to hide to select several layers click and drag within the Eye column to select the layers at once

These layers are now hidden. 
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Photoshop Toolbox Reference

This section of the site is a comprehensive Photoshop Toolbox reference. Click on a tool to view its video-manual*.

	Icon
	Tool
	Key
	Purpose
	 
	Icon
	Tool
	Key
	Purpose

	


	Elliptical Marquee
	M
	selecting
	
	


	Single Row Marquee
	-
	selecting

	


	Rectangular Marquee
	M
	selecting
	
	


	Single Column Marquee
	
	selecting

	


	Lasso
	L
	selecting
	
	


	Move
	V
	transforming

	


	Polygonal Lasso
	L
	selecting
	
	


	Magic Wand
	W
	selecting

	


	Magnetic Lasso
	L
	selecting
	
	


	Crop
	C
	transforming

	


	Slice
	K
	web design
	
	


	Slice Select
	K
	web design

	


	Healing Brush
	J
	retouching
	
	


	Patch
	J
	retouching

	


	Brush
	B
	painting
	
	


	Pencil
	B
	painting

	


	Clone Stamp
	S
	painting
	
	


	Pattern Stamp
	S
	painting

	


	History Brush
	Y
	restores to selected history state
	
	


	Art History Brush
	Y
	painting

	


	Airbrush
	J
	painting
	
	


	Eraser
	E
	erasing

	


	Background Eraser
	E
	erasing
	
	


	Magic Eraser
	E
	erasing

	


	Paint Bucket
	G
	painting
	
	


	Gradient
	G
	painting

	


	Blur
	R
	unfocusing
	
	


	Sharpen
	R
	focusing

	


	Smudge
	R
	painting
	
	


	Sponge
	O
	color adjustment

	


	Dodge
	O
	tonal adjustment
	
	


	Burn
	O
	tonal adjustment

	


	Horizontal Type
	T
	typing
	
	


	Vertical Type
	T
	typing

	


	Horizontal Type Mask
	T
	typing
	
	


	Vertical Type Mask
	T
	typing

	


	Direct Selection
	A
	drawing
	
	


	Path Selection
	A
	drawing

	


	Pen
	P
	drawing
	
	


	Freeform Pen
	P
	drawing

	


	Add Anchor Point
	-
	drawing
	
	


	Delete Anchor Point
	-
	drawing

	


	Convert Point
	-
	drawing
	
	


	Rectangle
	U
	drawing

	


	Rounded Rectangle
	U
	drawing
	
	


	Ellipse
	U
	drawing

	


	Polygon
	U
	drawing
	
	


	LIne
	U
	drawing

	


	Custom Shape
	U
	drawing
	
	


	Eyedropper
	I
	choosing color

	


	Color Sampler
	I
	color information
	
	


	Measure
	I
	geometrical measurements 

	


	Notes
	N
	non-printable data
	
	


	Audio Annotation
	N
	non-printable data

	


	Hand
	H
	navigating
	
	


	Zoom
	Z
	image viewing

	


	Color Selecting box
	-
	displays current color
	
	


	Color Replacement
	J
	retouching

	


	Mode Selector
	Q
	selecting
	
	


	Jump to Image Ready
	Shift+
Ctrl+
M
	web design
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Note: The layer at the top of the list is the layer in front of all the other layers you can move (drag) layers up and down to get images in the correct stacking order.  


Note you cannot move the background layer.
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